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Audio Typing:                                                 

(lastmodified=11/12/23) 

(lastmodified=01/02/24)  

 

 

 

About this form: 
This form is the instruction form for audio typing.  

 

General overview: 
They are two different types of audio typing. Simplified format and 
detailed format. There is just one audio typist form. However, this 
form explains these two different types of audio typing. It also 
explains how to fill out the audio typist form. 

 

The two formats: 
Simplified:

In simplified format you simplify the sermon(s) by including all the 

citations, but no direct quotes. The citations from the scriptures are 

not to include their corresponding quotes. Also, anything the 

Preacher says is to be summarized by yourself, preferably in a few 

sentences. 

Detailed: 

In the detailed format, everything is to be written word-for-word. 

For extensive scriptures quoted you may want to use the Kindle of 

the Sacred Scriptures Bethel Edition and copy the scripture from 

there (download ‘Kindle for PC’ from Amazon). We recommend 
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tackling detailed formats as a collaborative assignment, which 

volunteers will be able to do, but contributors can get together and 

try this also. 
 

 

 

Before sections A, B and C are mentioned we added in February 2023 the ability to put whether you 
are a contributor or volunteer in one of the online groups. Select ‘contributor (N/A)’ if you have not 
been put in to an online group by the AOY. Just click on ‘Choose an item’ and select ‘Contributor 
(N/A)’. If you have been put in to an online group, select the group to which you belong. Please do not 
select a tribe if you have not been put in one by the AOY. 
 

 

 

1. If it’s a weekly Sabbath sermon that has been broadcasted within the past 24 hours or so, then 

download the announcement sheet from the Assemblies of Yahweh streaming site. 

a. To do this, go to section A, and then click on the checkbox if you have the 

announcement sheet, then go to insert > object > Adobe Acrobat Document. 

Before  selecting it, check/tick the box which says Display as icon.  A dialogue box 

should come up telling you to locate the file. Here, you must find the downloaded 

announcement sheet and double click. Note: if there is no announcement sheet 
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available on the AOY site in the User Streaming Area, then simply leave the tick box 

unchecked. 

 

b. If it does not have an announcement sheet due to it being an older sermon, or some 

technical  issue, leave the tick symbol unchecked (     ) so that the cross symbol only 

remains in section A.  

c. Also, in this same box goes the MP3 or WAV file. All sermons you type up MUST 

have an accompanying MP3 or WAV file, except if you are audio typing 

something from the streaming service. If a sermon isn’t available for download on 

the AOY streaming site, then do not type it up. The exception to this is if the AOY 

requests you to do this. Go to the AOY streaming site and download the sermon then 

go to insert > object. Once done, you can fill in the date on the same row (2 columns 

right). The sermon date should be the date in which the sermon was first 

broadcasted.  

2. Once section A is complete, go to section B. Here you must write today’s date 

(whatever the date is when you fill out the form) and your name as 

well as the names of the individuals who helped you audio 

type if you did collaborative audio typing. Whoever is 

sending the Living Way the form should put their name 

first. That individual is the one who must take 

responsibility for the accuracy of the audio 

typed sermon. In section C, you are to 

write the Preacher’s name 

and what type of sermon it 

is, whether mini sermon, 

or main, or both, followed 

by a dash and the format 

of audio typing you are 

using i.e. – simplified or 

detailed. If audio typing on the 

form has been done by more than 

one person, insert the number of people 

involved in brackets next to the format 

i.e. – detailed (3). Below is an example of 

how these sections should look properly filled out:  

 

Note: If it’s a weekly Sabbath service that you are typing up, use both the blue and purple grids for 

typing up the mini and main sermons, respectively and put ‘Sabbath’  next to  ‘Holy Day type’ box in 

section C.   
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A. Announc

ements 

sheet  

and MP3 

 

Sermon Date: 

Service Date: 

Holy Day type: 

16 March 1991  

16 March 2013 

Sabbath 

B. Today’s 

Date: 

22/11/2013 Your Name: 

Other typists: 

John Smith 

C. Preacher Elder Jonathan S. Meyer  

Elder Jacob O. Meyer 

Type of 

sermon: 

Mini – Detailed 

Main  - Detailed (3) 

The Assemblies of Yahweh have kindly made available sermons on their AOY site which members 

can login to and listen to. These will need to be audio typed at some point also especially for the sake 

of translation and new people coming in to the faith. If you are audio typing one of these sermons 

rather than the streaming, type the category or categories where the sermon is found that you are 

audio typing. We added section D in order to do this in February 2020.  

The audio sermons categories on the AOY site are currently (18th February 2020) the following: 

• Sacred Name 

• Sabbatical 

• Sabbath 

• Recent 

• Prophetic 

• Obedience 

• National Holiday 

• Love 

• Historical 

• Full List 

• Feast Days 

• Faith 

• Doctrine 

• Dedication 

• Bible Studies 

Within those categories are sub categories, such as in the Sacred Name category are the sub 

categories Yahweh and also Yahshua. In the category Obedience, are the sub categories Separation, 

Faithfulness, Lifestyle etc.  

In section D in ‘Location’ if it’s Streaming, you would just write ‘Streaming’, but if it is an audio sermon 
you are typing from the site, write the categories that the sermon falls under. The sermon The 
Salvation of Yahweh, Delivered by Deacon Nathaniel A. Meyer, Saturday, January 7, 2012 is in the 
Sacred Names category, under Yahshua would be written as Sacred Name > Yahshua in the 
Location field as seen below. This will make it easier for the website manager to locate where audio 

Adobe Acrobat 
Document

Figure 1-The Assemblies of Yahweh have come a long way 

from using cassette tapes 
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typed sermons need to be uploaded to: 

 

(NOTE: The AOY appear no longer (29th November 2023) to have downloadable sermons on their 
site in favour of going to wmlkradio.com which sermons cannot be currently downloaded or rewinded) 

 

This will probably be done by those who are online volunteers. If you’re typing up streaming services 

sermons, you can either type up the latest Streaming by logging in to the AOY site and going to 

Members > Live Service Stream and then typing up the sermon(s) there on the live stream page (it 

may take you to Youtube). Or you can access previous streamed services by clicking on ‘Youtube 

Sermon Links’ under the Video Stream i.e. 

 

This list is updated and the links contain the date when the sermon was broadcasted.  

If you are typing up both Mini and Main sermon from the streaming, you can put Mini & Main in the 

‘Type of Sermon’ in Section C. In Section D, in the ‘Location’ row, put ‘Streaming’. 

If you are typing the streaming, you may want to reduce the playback speed by going to the little gear 

icon and changing the Playback speed so it is slower.  

 

It is hoped that audio typed sermons can appear on the AOY site next to the 

sermons. If a link is given to OneDrive, and the audio typed 

sermons are on there, then users will be able to select the 

language that they want to read the audio typed sermon in. 

Alternatively, another program could be used, but typed 

sermons are so much more readily translatable than audio. This will 

be a big help to completing the great commission to ‘teach’ all 
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nations, as all can receive the same material the English speaking brethren receive and be edified. 

Thus the AOY site will be very useful to those all across the globe who have an interest in the truth 

and all will be able to read the pertinent messages broadcasted from Bethel each week which many 

times are based on the issues that the AOY is facing, or the other sermons that the AOY have made 

available online. 

Mini sermon is light blue, Main sermon is 

purple 

Please ensure that if you are typing up a mini sermon, use the light  blue grid (section E) and if you 

are typing up a main sermon, use the purple grid (section F) when typing the notes.  

 

 

Detailed sermon notes & simplified 

In detailed sermon notes one is to record every word that was spoken in the sermon. This will be the 

most useful format for creating challenges, quizzes, puzzles, also for translation and additionally, for 

people who have hearing problems in the AOY.  

In simplified sermon notes the words spoken by a Preacher for each row should exceed no more 

than 100 words. Rather, whatever the Preacher has said can be summarised in relatively few words 

like: “The Preacher explains that he is concerned about the effect that the internet and television are 

having on the people of society today ”. Please ensure that in the simplified notes format, you 

summarise what was said properly. This might be useful for the AOY if they want to add citations to a 

sermon as it is playing on streaming.  

Symbols and abbreviations to use in 

For the opening chapter in the sermon, put OC prior to the scripture. Only do this if the full chapter is 

used. You do not need to and should not quote the entire chapter.  

D. Notes 

 Write Book, 

Chapter and 

Verse 

Or Preacher 

Quote: 

 

For Verifier 

 

1.  OC Psalm 

34 

  



7 | P a g e  

 

 

Below are the symbols that you should use when quoting a preacher. The first is  the writing ‘hand’ 

symbol. You use this as the standard symbol whenever you are writing down what they say. The 

question mark symbol is used if the Preacher has asked a question to the audience, usually relating 

to self-examination. The ‘And’ symbol is for when the Preacher recounts a story. The two jagged 

horizontal line symbol is to be used for anything that might present a problem if attempted to be 

translated, such as a joke which wouldn’t make good sense in a different culture. The arrow symbol is 

explained further down, it is used to connect scriptures. The Torah symbol is to be used when one of 

the 10 commandments is referenced.                                       

  

When quoting scripture, the only symbol you should use, if any, is the upwards arrow, to connect 

scriptures. When writing down what the Preacher says please note that the ‘hand’ symbol is what you 

normally use but you can replace that symbol with one of the other ones if one of those categories 

come up. You may have more than one symbol in a section. They are useful for overviewing the 

document for those subjects so try to include them when you can. If you don’t have space, don’t worry 

about it.  

When you are quoting scripture with 

more than one verse, give everything 

but the first verse you quote a verse 

number. You can just write the verse 

number or do it by using brackets “( )” 

and inserting the verse number in those 

brackets i.e. 

 

1.  Deuteronomy 6:4 

– 9 

“Hear O Israel: Yahweh is our Elohim, Yahweh is 

one (5) and you shall love Yahweh your Elohim 

with all your heart, and with all your soul, and with 

all your might.  

 

 

Feel free to italicise those words which the Preacher emphasises rather than use the Bold feature.  

Breaking off from a quote

If the Preacher has quoted from a passage and breaks off to explain some word or aspect of the 

verse, then in the citation put the  entirety of what the Preacher is quoting from and in bold i.e. 
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Deuteronomy 6:4 – 9, but when the Preacher goes back to continue the verse(s) after he has 

interjected it, then insert the arrow symbol seen below in the citation box, copy and paste the specific 

chapter number and verse number(s) next to the arrow and use the verse bracket symbol “( )” on 

every verse including the first one from then on in when continuing to write the quote out in the box 

adjacent. Alternatively, you can just use the brackets to show the first verse number in the section you 

are quoting from, but after just use the number verse it is without the brackets in that row which would 

be useful for if you are copying your quote from ‘Kindle for PC’ from Amazon. There might be a 

number of these arrow symbols pointing back to the original citation if the Preacher is endeavouring to 

cover verses in detail.  

You may have to listen to the sermon for an extended period of time to find out the full extent to which 

the Preacher quoted from a passage and then fill the details in. Please do view the Example PDF on 

the Messianic Israelite site.  

You are only to do this if the Preacher continuously quotes from subsequent verses from a chapter. If 

they skip a verse or verses, you are to write anew the passage. 

Please see below a demonstration: 

Deuteronomy 6:4 - 9 “Hear O Israel: Yahweh is our Elohim, 

Yahweh is one (5) and you shall love 

Yahweh your Elohim with all your 

heart, and with all your soul, and with 

all your might.  

 

Preacher 

We have to love Yahweh from the 

heart.  

 

 6:4 - 9 

“ (6) And these words which I 

command you this day shall be upon 

your heart; and you shall teach them 

diligently...” 

 

If you encounter a word that a Preacher states and it is foreign to the English 

language, write the word and use these brackets “[ ]” to write in what the 

language of the word is, abbreviating the language to the first three letters, and 

before closing the bracket, using a full stop and a space i.e. “Shema [Heb. ]”. If 

you’re not sure how it is spelt, as with any word you are unsure of, highlight the 

word and change the letter colour to red and separate the word by syllables with 

apostasies i.e. “She’ma [Heb. ]”. However, you should find a concordance online, 

or dictionary to enable you to spell the words you encounter correctly. Just typing 

the word in to Google search will usually yield results. 

Note: Anything that is perhaps to be deleted from the document is to be highlighted yellow and this 

includes the abbreviated words of the language in the squared brackets. It also includes the symbols 
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in the next section. Highlighting these things yellow will mean they will be easily found in the 

document even when translated. 

(...)(_)(X)(O)  

If you use any symbols, they must be highlighted in the yellow color. The Text Highlight Color option 

is found in the Font section of the Ribbon in Microsoft Word.  

 

Also, you are to use this symbol (...) to show that you have missed content because of a late 

recording or otherwise some technical issue such as buffering issues which prevent you from 

recording content hence the three dots, this symbol (_) to show that you have skipped unnecessary, 

superfluous talk i.e. if the Preacher backtracks on himself because they quoted the wrong scripture, 

hence the underscore and this symbol (X) if you skipped something that was said because you 

couldn’t decipher what was said properly, hence the cross. If you have corrected something the 

Preacher says then use this symbol with the capital O in brackets (O). This might be if the Preacher 

meant to say one word but said another, or quoted from a scripture but used the wrong citation. You 

may correct what they have said as long as you put this symbol and underline the words that are, or 

have been changed. The O stands for ‘over’ as you have to edit what was said. 

Time in  and Time Out  and collaborative 

This is especially important for collaborative 

audio typing, which is if you are audio typing in 

a team. We advise to use OneDrive for this 

where you can send a link to the document(s) 

for others to edit. If online volunteering becomes 

available, documents could be sent to be edited 

over the internet to the different volunteers. You 

are to use the clock symbols mentioned in the 

next paragraph to show that you have ‘timed in’ 

or ‘timed out’. Note: Currently, you cannot insert 

the symbol from OneDrive’s symbol list, but on 

the Audio Typing form at the bottom of the 

document we have included these symbols there so you can just copy and paste them in the 

document. 

You are to use this quarter-past time symbol  when you time-out so to speak, especially if someone 

else is to take over from where you left off. To do this insert the time symbol and write the duration 

time you have got up to in the sermon and your full initials i.e.  10.00 J.S (John Smith). If the 

same person times-in, and continues with the piece, then they’ll know exactly at what point in the 
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sermon they are at, they can then delete the time-out text, in this case,  the ‘ 10.00 J.S’.  If another 

person in the team takes over from where the other has timed out, then they must leave the time-out 

text there and just below it insert this quarter-to time in symbol  and their name i.e. J.B. to show 

they have timed in. Below is an example of symbols used in this section properly: 

 

D. Notes 

 Write Book, 

Chapter and 

Verse 

Or Preacher 

Quote: 

 

For Verifier  

2.  Matthew 17:20 “And he says to them, Because of your little faith: 

for truly I say to you, if you have faith as a grain of 

mustard seed you shall say to this mountain, 

Remove from here to yonder place; and it shall 

remove; nothing shall be impossible to you” 

 

3.  

 

Do we have faith in Almighty Yahweh to supply 

our needs?  

 

4.  2 Timothy 3:16 “Every scripture Yahweh breathed is also 

profitable...” 

 

 
5.  

Preacher 

 

We can only get to the Kingdom of Yahweh if we 

are using the tools that Yahweh has given us to 

get there. (_) We should be praying, we should 

be studying the Word, we should be fasting.  

 

  10.00 J.S  

 

 

 

If you are struggling at all to use the time in, time out symbols, go to the insert > symbols option in 

OneDrive and just use the Alpha α symbol to time in and the Beta β symbol to time out.  

Working on the same document to get audio typing done will be enjoyable as you see your work 

coming together with other volunteers to create a fully audio typed document. Feel free to add 

‘comments’ through the Review tab in OneDrive if you have any comments you want to leave for the 

other users or want to message other users within the document. Feel free to add a comment using 

Review > Comments, and you can even include a positive comment about something the Preacher 
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has said, but please do write your name when you do so we know who the comment was from. You 

may comment on what other people have done too.  

An example of a good comment would be: 

 

 

 

 

 

 

Indeed, if you could start your comment with ‘Yom Tov’ or ‘Shalom Alleichem’ or some other Hebrew 

greeting, end your comment with ‘Yahweh bless’, or ‘Shalom’ or something positive like that, and use 

the term ‘in Philadelphia love’ or in ‘Messianic love’ as the will of Elder Meyer was that we remain in 

Philadelphia and we can do that even when leaving messages for each other in OneDrive.  

Audio typed forms can be used very well in the Quote It category. If you receive an audio typed form 

of a sermon and are asked to use it for Quote It purposes, highlight any quotes you think would be 

good quotes to use in the Quote It category by using the blue highlight tool colour. This still comes 

under the Audio Typing category. This is then sent to a volunteer in Quote It to transfer the quotes 

across to the Quote It forms.  

‘Reflect’

There is a reflect box which is at the bottom of the document. Feel free 
to use it to reflect on the message, or reflect on how you found the 
audio typing, if you had any problems or whatever it may be. This 
may be contributed to by a number of different people if collaborative 
audio typing. You may use it to leave a message for another audio 
typist or verifier.  

Yom Tov! I just wanted to remind user Joe Bloggs if they can separate text by paragraphs 
so the verifier has an easier time verifying the document. I have done this for you but if you 
could do this in the future that would be great. Thanks for all your great work. Yahweh bless! 
In Philadelphia love, John Smith’. 



12 | P a g e  

 

In November 2020 we added the spirituality corners. This is for those who do online volunteering for 

their tribe. It shows what spirituality points can be obtained by doing the assignment. You can obtain 1 

study point in this category. 

  

Feel free to skip over these if you are not an online volunteer.   

Spirituality points are added to the tribes overall points.  

The main goal of these categories is to help nurture the Holy Spirit and even though a Living Way 

email address hasn’t been created as of yet to enable contributions or volunteering, the editor hopes 

those who can, to use the seven categories on messianicisraelite.com to help foster their spirituality in 

the meantime however, for their own personal use. 

Using people’

Occasionally and naturally, names of people are mentioned in the sermon. If a name of a person 

comes up in a sermon highlight the name using the Text Highlight Tool in Microsoft Word with the 

gray – 25% colour. 

 

If they have left the faith, and in the sermon it makes out like they are in the faith, you should edit out 

their name using the (O) symbol as explained previously in this document. This is so there isn’t 

confusion with people thinking that certain people are in the faith when in actuality, they are not.  
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Notes for verifiers 

Please label the verify column with alphabetisation for each 

paragraph contained in the notes and verify the work by 

paragraph rather than by row.  When you get to each new row, 

start the alphabetisation (from A – Z) for each paragraph 

again. Then you may use the tick for successfully verifying that 

section, or a cross, for a section that failed verification. If you 

have time, amend the pieces that failed verification 

yourself.  
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Also, use this  clock symbol next to those subjects that are covered extensively in simplified 

sermon formats. Use this sparingly; often this should only be used once on a main sermon typist 

form for subjects that take about 20 minutes or more to cover. Insert the clock symbol and write how 

many minutes this part takes us i.e.  23.00 

This will help us to synchronize the ‘lyrics’ to the sermon for the AOY.  

 

 
 

Preacher 

 
 23.00 

The Preacher gives a detailed report on his 

latest trip to Israel. It includes his visit to the 

Temple Institute in Jewish Quarter and the 

Walt Museum  
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Audio typing is brilliant for translation and for use for the deaf. For translation purposes this is what 

you should do. When you get a detailed audio typing form you can send it to a translator in the AOY. 

The translator should open the document, but save the document under a different name and open 

that document also.  On Microsoft Windows 2007 

and later you can go to the top of the document 

where it says View > View Side by Side. Once 

you have both documents of the same thing 

viewing side by side, they should be easily be able 

to translate due to how the audio typing form is 

organised with symbols etc. They would just have 

to delete the English text on the second document, 

and replace it with the translated text. Once 

finished, they should be able to send you back the 

translated document which you could then upload 

to the AOY site or send to those who need it.  

If a translator is saving the translated document they should use the format as mentioned in the below 

section called ‘Saving this document and emailing it in’, but at the end add an underscore followed by 

the translation language they’ve translated the document in to. For example: 

Audio_Tending The 

Sheep_DMiniSermon_JS_14042013_

Certain languages have more than one dialect of course, so if you can make it clear what dialect the 

language is in the language part it would be much appreciated.  

Documents in OneDrive can be translated automatically to other languages in the Review tab > 

Translate 

  

…so OneDrive will be an excellent tool to use for audio typing. However, it is not known how accurate 

this is. Ussually automatic translations like this aren’t very reliable. If possible, the document should 

always be checked and corrected for readability by a translator in the AOY or person who can read 

that language before being sent off to those who might have need of it.  
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When you have completed this sheet, save it as Audio_[Insert title of sermon]_[Insert D for Detailed or 

S for Simplified format][Insert Mini or Main]Sermon_[insert your full initials]_[insert today’s date]. An 

example would be:  

Audio_Tending The 

Sheep_DMiniSermon_JS_

If the sermon was audio typed by more than 1 person, put one persons initials name in the group and 

follow that by the number of people who worked in your team to do the audio typing. The below shows 

that 2 people worked in a team to get the audio typing done. Whoever’s initials is on the file name, 

they must take responsibility for the accuracy of the audio typed sermon. 

Audio_Tending The 

Sheep_DMiniSermon_ _

If the audio typing done is from the streaming containing  two sermons, use the following format 

instead: AudioSteam_[Insert Sabbath/NewMoon/1stHighDayofUBMorning etc]_[Insert date service 

took place]_ ]_[Insert D for Detailed or S for Simplified format]_[insert your initials]_[insert today’s 

date]. An example would be:  

AudioStream_Sabbath_18072010_S_JS_

Email your completed audio typed sermon(s) to the Living Way.  

NOTE:  

Date format is now month 00, day 00 and year 0000 

Difference between ‘contributors’

from ‘volunteer’

At the present time (February, 2016), messianicisraelite.com has been set up as a foundation to 

which anyone affiliated with the AOY and is 16 or over may contribute work or good fruit to the 

Assemblies of Yahweh or Yahweh himself through the internet via the Living Way Youth Program. 

The individuals that send work to the Living Way by this method are called contributors. 

The difference between the volunteers and contributors would be that volunteers would be dedicated 

online workers, producing work consistently every 2 weeks, or, ‘every season’, whilst contributors 

would just send in work whenever they can or want to.  

Below is what you need to know about the audio typing category if you are considering becoming a 

volunteer for the future.  
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The problem with contributions for audio typing is this. We have 

made the rule that unless the AOY has asked one to audio type 

another sermon, all digital sermons audio typed must come from the 

AOY site. However, obviously then, the Living Way will have to 

produce a list of all the sermons that have been audio typed, 

probably updating that list every week and publishing it so that 

contributors do not audio type the same sermons. Possibly, this 

could just be shown by those sermons that do not have an 

audio typed sermon next to them on the AOY site. Further, at 

certain times, the AOY will have need of a sermon to be audio typed and/or 

translated, which is where volunteers come in.  

The streaming enables us all to be united in us all listening to the same service each Sabbath. We 

cannot underestimate the importance of streaming. When people come in to the AOY who do not 

speak the English language, then they will have a problem, unless the services preached were 

translated and so audio typists can do this and the Living Way can receive and then the AOY send 

out, the translations by email. Because the main sermon is usually already pre-recorded, the sermon 

can be audio typed and even translated before it is even broadcasted from Bethel, allowing the 

Assemblies of Yahweh to sync the lyrics with the video. It’s more than likely translation tools will 

improve, especially on YouTube, since it’s now owned by Google.  

If it is Yahweh’s will, assignments will come to volunteers through assignment sheets. They are a 

number of different assignments one could receive as a volunteer. Below is just a snippet of an audio 

typing sermon assignment found on a assignment sheet: 

 

Because the volunteers will be working in online groups collaboratively, different volunteers could 

work on different parts of the same sermon and even at the same time thanks to OneDrive and 

therefore we can split the big task of audio typing sermons in to bitesize chunks. Five people audio 

typing an  hour long sermon would only have to do 20 minutes each. Further, we will need people 

who can work in other languages other than English for the translation purposes to help out with that. 

The AOY may choose to send out sermons to be audio typed each week, especially following the mini 

and main sermons being preached from Bethel. Being able to work together to do good for the 

ministry is a blessing and this will really help to spiritualize those who do these tasks, but also help out 

the Assemblies of Yahweh internationally too. Audio typed sermons can be processed and used for 

Quote It purposes also. The categories of messianicisraelite.com are interlinked.  

The vision the editor has is that the Assemblies of Yahweh could have an army of volunteers, online 

volunteers all over the world, who are beautifying the Assemblies of Yahweh both internally and 

externally and working in the Word of Yahweh, not only to strengthen themselves spiritually, but to 

strengthen all those who share in their works. This Body is the Truth, and we want to prepare this 

glorious Body as a beautiful Bride of the Messiah so Yahshua our Savior and soon coming King will 

be pleased at His Coming and even before that, that Yahweh could look down from heaven and see a 

people who love Him, love His Word, love Yahshua and love each other. The world may be becoming 
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more evil and corrupt, but in the Assemblies of Yahweh we want to be becoming more spiritual, more 

loving. Let us prove to Yahweh our love every day and make the Assemblies of Yahweh the type of 

organization that Elder Jacob O. Meyer (OBM) envisioned years ago. 

 

Just so you know, we have a OneDrive friendly version of the audio typing form which would be 

shared with online volunteers. Also, you may have tried to do some audio typing yourself and are 

wondering how one is able to keep up typing at the pace of speed the Preachers speak, or anyone 

speaks? It’s not that we’re superfast at typing. You can slow down speech in settings on the 

Streaming in Youtube by clicking on the cogs icon and changing the speed there. We in the below 

example demonstrate it with Windows Media Player. First, open your sermon/service media file in 

Windows Media Player. Next, right-click anywhere within the player. You should get a screen like this: 

 

As you may be able to see, you can go to Enhancements > Play speed settings.  Then click on ‘slow’.  

 

It will then play the file slower than normal so you can keep up with typing. Course, even then you will 

have to rewind it back at times to accurately record what has been said.  
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“29 Yahshua answered, The first is, Hear, O Israel” 

  Mark 2:29 

  Sacred Scriptures Bethel Edition 

 
“The parable of the sower, the four soils, is dependent upon the hearing the Word, if we are to bear fruit.” 

  An Open Ear To Hear Yahweh’s Word 

  Elder Jacob O. Meyer 

 

www.messianicisraelite.com 
“Open the door” 

 
 

Hoped to be part of the: 

 
 
DISCLAIMER: This site has not yet been endorsed by the Assemblies of Yahweh and is 

not a part of the Living Ways Youth Program. The editor – a member of the Assemblies 

of Yahweh - has built this site to be part of the Living Way Youth Program, a program 

of the Assemblies of Yahweh (Bethel, PA). 

 
 

http://www.messianicisraelite.com/

